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SOFTWARE LICENSE AGREEMENT

INSTALLING OR OTHERWISE USING THIS SOFTWARE PRODUCT CONSTITUTES YOUR 
ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS (UNLESS A SEPARATE 
LICENSE IS PROVIDED BY THE SUPPLIER OF APPLICABLE SOFTWARE IN WHICH CASE 
SUCH SEPARATE LICENSE SHALL APPLY). IF YOU DO NOT ACCEPT THESE TERMS, YOU 
MAY NOT INSTALL OR USE THIS SOFTWARE, AND YOU MUST PROMPTLY RETURN THE 
SOFTWARE TO THE LOCATION WHERE YOU OBTAINED IT.

THE SOFTWARE INSTALLED ON THIS PRODUCT INCLUDES NUMEROUS INDIVIDUAL 
SOFTWARE COMPONENTS, EACH HAVING ITS OWN APPLICABLE END USER LICENSE 
AGREEMENT (“EULA”). INFORMATION RELATING TO THE EULAS MAY BE FOUND IN AN 
ELECTRONIC FILE INCLUDED ON THE USER DOCUMENTATION CD-ROM INCLUDED 
HEREWITH; HOWEVER, ALL SOFTWARE AND DOCUMENTATION DEVELOPED OR CRE-
ATED BY OR FOR TOSHIBA TEC CORPORATION (“TTEC”) ARE PROPRIETARY PROD-
UCTS OF TTEC AND ARE PROTECTED BY COPYRIGHT LAWS, INTERNATIONAL TREATY 
PROVISIONS, AND OTHER APPLICABLE LAWS.

Grant of License
This is a legal agreement between you, the end-user (“You”), and TTEC and its suppliers. This 
software, fonts (including their typefaces) and related documentation (“Software”) is licensed for 
use with the system CPU on which it was installed (“System”) in accordance with the terms con-
tained in this Agreement. This Software is proprietary to TTEC and/or its suppliers.

TTEC and its suppliers disclaim responsibility for the installation and/or use of this Software, and 
for the results obtained by using this Software. You may use one copy of the Software as 
installed on a single System, and may not copy the Software for any reason except as neces-
sary to use the Software on a single System. Any copies of the Software shall be subject to the 
conditions of this Agreement.

You may not, nor cause or permit any third party to, modify, adapt, merge, translate, reverse 
compile, reverse assemble, or reverse engineer the Software. You may not use the Software, 
except in accordance with this license. No title to the intellectual property in the Software is 
transferred to you and full ownership is retained by TTEC or its suppliers. Source code of the 
Software is not licensed to you. You will be held legally responsible for any copyright infringe-
ment, unauthorized transfer, reproduction or use of the Software or its documentation.

Term
This license is effective until terminated by TTEC or upon your failure to comply with any term of 
this Agreement. Upon termination, you agree to destroy all copies of the Software and its docu-
mentation.

You may terminate this license at any time by destroying the Software and its documentation 
and all copies.

Disclaimer of Warranty
THIS SOFTWARE IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE, AND NON-
INFRINGEMENT. TTEC AND ITS SUPPLIERS DISCLAIM ANY WARRANTY RELATING TO 
THE QUALITY AND PERFORMANCE OF THE SOFTWARE. IF THE SOFTWARE PROVES 
DEFECTIVE, YOU (AND NOT TTEC OR ITS SUPPLIERS) SHALL BE RESPONSIBLE FOR 
THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION. TTEC 
AND ITS SUPPLIERS DO NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR FREE.
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ALL INFORMATION CONTAINED HEREIN THAT IS PROVIDED BY TTEC AND ITS AFFILI-
ATES PURSUANT TO A EULA IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED.

Limitation of Liability
IN NO EVENT WILL TTEC OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES, 
WHETHER IN CONTRACT, TORT, OR OTHERWISE (EXCEPT PERSONAL INJURY OR 
DEATH RESULTING FROM NEGLIGENCE ON THE PART OF TTEC OR ITS SUPPLIERS), 
INCLUDING WITHOUT LIMITATION ANY LOST PROFITS, LOST DATA, LOST SAVINGS OR 
OTHER INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE 
USE OR INABILITY TO USE THE SOFTWARE, EVEN IF TTEC OR ITS SUPPLIERS HAVE 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, NOR FOR THIRD PARTY 
CLAIMS.

U.S. Government Restricted Rights
The Software is provided with RESTRICTED RIGHTS. Use, duplication or disclosure by the 
U.S. Government is subject to restrictions set forth in subdivision (b) (3) (ii) or (c) (i) (ii) of the 
Rights in Technical Data and Computer Software Clause set forth in 252.227-7013, or 52.227-19 
(c) (2) of the DOD FAR, as appropriate. Contractor/Manufacturer is TOSHIBA TEC Corporation, 
6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.

General
You may not sublicense, lease, rent, assign or transfer this license or the Software. Any attempt 
to sublicense, lease, rent, assign or transfer any of the rights, duties or obligations hereunder is 
void. You agree that you do not intend to, and will not ship, transmit (directly or indirectly) the 
Software, including any copies of the Software, or any technical data contained in the Software 
or its media, or any direct product thereof, to any country or destination prohibited by the United 
States Government. This license shall be governed by the laws of Japan or, at the election of a 
Supplier of TTEC concerned with a dispute arising from or relating to this Agreement, the laws of 
the Country designated from time to time by the relevant Supplier of TTEC. If any provision or 
portion of this Agreement shall be found to be illegal, invalid or unenforceable, the remaining 
provisions or portions shall remain in full force and effect.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE AGREEMENT AND THAT 
YOU UNDERSTAND ITS PROVISIONS. YOU AGREE TO BE BOUND BY ITS TERMS AND 
CONDITIONS. YOU FURTHER AGREE THAT THIS LICENSE AGREEMENT CONTAINS THE 
COMPLETE AND EXCLUSIVE AGREEMENT BETWEEN YOU AND TTEC AND ITS SUPPLI-
ERS AND SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, 
OR ANY OTHER COMMUNICATION RELATING TO THE SUBJECT MATTER OF THIS 
LICENSE AGREEMENT.

TOSHIBA TEC Corporation, 6-78, Minami-cho, Mishima-shi, Shizuoka-ken, 411-8520, Japan.
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TRADEMARKS AND COPYRIGHT

Trademarks
The official name of Windows 98 is Microsoft Windows 98 Operating System.
The official name of Windows Me is Microsoft Windows Me Operating System.
The official name of Windows NT is Microsoft Windows NT Operating System.
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating 
System.
Microsoft, Windows, Windows NT, and the brand names and product names of other 
Microsoft products are trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, TrueType, and LaserWriter are trademarks of Apple Inc. 
in the US and other countries.
PostScript is a trademark of Adobe Systems Incorporated.
Netscape is a trademark of Netscape Communications Corporation.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respec-
tive companies.

Copyright
© 2007 TOSHIBA TEC CORPORATION All rights reserved
Under the copyright laws, this manual cannot be reproduced in any form without prior written 
permission of TTEC. No patent liability is assumed, however, with respect to the use of the infor-
mation contained herein.
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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems or Multifunctional Digital 
Color Systems. This Network Fax Guide explains instructions on how to use the N/W-Fax driver 
and Address Book Viewer.  Read this guide before operating the network fax features for the 
Multifunctional Digital Systems or Multifunctional Digital Color Systems from client computers.  
Keep this guide within easy reach, and use it to configure an environment that makes best use 
of the e-STUDIO’s functions.

About This Guide
The Network Fax Guide provides detailed instructions for installing, setting up and using the 
optional Network Fax Feature for the e-STUDIO452 Series, e-STUDIO453 Series, e-
STUDIO282 Series, e-STUDIO283 Series, e-STUDIO852 Series or e-STUDIO853 Series. With 
this option installed, you can perform the following functions:

Fax electronic documents from your workstation.
Use the N/W-Fax driver installed on your workstation to manage faxes: select recipients and 
send electronic documents from your desktop.
Use the Address Book Viewer installed on your workstation to manage recipient information.

Conventions
The term “this equipment” in this manual refers to the Multifunctional Digital Systems or Mul-
tifunctional Digital Color Systems.
The term “e-Filing” in this manual is an abbreviation of “electronic filing”.

Lineup of Our Manuals
Thank you for purchasing the TOSHIBA Multifunctional Digital Systems or Multifunctional Digital 
Color Systems.
We have provided you with these manuals for the operation of this equipment. Select and read 
the manual best suited to your needs.

Quick Start Guide
This Quick Start Guide describes the initial setup method of this equip-
ment and accessories of this product such as operator’s manuals and 
CD-ROMs.

Operator’s Manual for Basic Functions
This Operator’s Manual for Basic Functions describes how to use the 
basic functions of this equipment mainly focusing on the copying func-
tion.
Also this manual contains safety precautions for users to be observed. 
Be sure to read it first carefully.
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User Functions Guide
This User Functions Guide describes the functions and settings under 
the [USER FUNCTIONS] button on the control panel of this equipment.

Color Guide (only for the color model)
This color Guide simply explains the functions such as “copy density 
adjustment”, “color adjustment”, “copy editing”, "image editing” and 
“image processing” in color. This guide also includes the basic knowl-
edge of color.

Other guides are provided by the User Documentation CD-ROM in PDF files:
TopAccess Guide
This TopAccess Guide explains how to operate and set up the network 
functions such as the network scanning function and job management, 
using the TopAccess (Web-based utility) from client computers.

Network Administration Guide
This Network Administration Guide explains the guidelines for setting up 
network servers to provide various network services, and troubleshoot-
ing for network administrators.

Printing Guide
This Printing Guide explains how to install the client software for printing 
from Microsoft Windows, Apple Mac OS, and UNIX computers, and print 
to the equipment.
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To read manuals in PDF (Portable Document Format) files
Viewing and printing this operator’s manual in PDF files require that you install Adobe Reader or 
Adobe Acrobat Reader on your PC. If Adobe Reader or Adobe Acrobat Reader is not installed 
on your PC, download and install it from the website of Adobe Systems Incorporated.

Scanning Guide
This Scanning Guide explains how to operate the scanning function of 
this equipment.

e-Filing Guide
This e-Filing Guide explains how to operate the e-Filing function using 
the TWAIN driver, File Downloader and e-Filing web utility.

Network Fax Guide
This Network Fax Guide explains how to use the network fax function 
that enable users to operate fax and internet fax sending from a client 
computer via network.

User Management Guide
This User Management Guide describes how to manage this equipment 
using the functions of “Department Management”, “User Management 
Setting” and “User Authentication for Scan to E-mail”.
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Precautions in this manual
To ensure correct and safe use of this equipment, this operator’s manual describes safety pre-
cautions according to the three levels shown below.
You should fully understand the meaning and importance of these items before reading this 
manual.

Other than the above, this manual also describes information that may be useful for the opera-
tion of this equipment with the following signage:

Indicates a potentially hazardous situation which, if not avoided, could result 
in death, serious injury, or serious damage, or fire in the equipment or sur-
rounding assets.

Indicates a potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury, partial damage of the equipment or surrounding 
assets, or loss of data.

Indicates a procedure you should follow to ensure the optimal performance of 
the equipment and problem-free copying.

Describes handy information that is useful to know when operating the equip-
ment.

They provide important descriptions of the operation.

Pages describing items related to what you are currently doing. See these 
pages as required.

black and white model e-STUDIO202L/232/282
e-STUDIO203L/233/283
e-STUDIO352/452
e-STUDIO353/453
e-STUDIO520/600/720/850
e-STUDIO523/603/723/853

color model e-STUDIO281c/351c/451c
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This section describes about the overview of the network fax features.
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Features and Functions

This equipment provides the network fax feature, which simplifies and facilitates your office fac-
simile needs that enables you to send fax or Internet fax digital documents directly from your 
desktop.
This equipment also includes an Address Book database, where you can store frequently used 
fax numbers or Internet Fax destinations and other important recipient information, such as com-
pany name, telephone number and postal address.

Fax transmission using the N/W-Fax driver is available only when the optional Fax unit is 
installed.

Functional Highlights
The highly intuitive, network N/W-Fax driver software enables you to select the fax printer driver 
to electronically faxes or internet faxes from your computer to one or more recipients. You can 
easily define fax job properties from the send list to fax resolutions. The N/W-Fax driver is com-
plimented with the Address Book Viewer. The combination of applications enables you to easily 
manage a selection of fax recipients and access the Address Book.

The image quality of the originals that are sent by the N/W-Fax driver is different from the 
originals that are sent by the general fax operation.
If you specify the email addresses as the recipients using N/W-Fax driver, the document will 
be sent as an Internet Fax.  The Internet Fax feature allows users to send originals, same as 
the fax features.  However, the Internet Fax is sent through the Internet, although the fax is 
sent through the public switched telephone line.  In order to send the Internet Fax, the 
remote device also must support the Internet Fax feature.
For more details about the Internet Fax, please refer to the Scanning Guide.

For e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282, e-STUDIO203L/233/283, e-
STUDIO520/600/720/850 and e-STUDIO523/603/723/853, fax transmission using the N/W-Fax 
driver is available only when the printer kit or the printer/scanner kit is installed. 
For e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282, e-STUDIO203L/233/283, e-
STUDIO520/600/720/850 and e-STUDIO523/603/723/853, internet fax transmission using the N/W-
Fax driver is available only when the printer kit and scanner kit are installed or the printer/scanner 
kit is installed. 
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Software Components

N/W-Fax Driver
The N/W-Fax driver enables you to set up send lists and send electronic documents from your 
PC to one or more destinations. You print to the fax much the same way you would choose to 
print to a designated printer that makes using the N/W-Fax driver quick and simple. You can 
select the fax properties. Fax properties are the attributes you can set to define sender and 
recipient information for processing fax jobs such as dialing options, sender information, fax res-
olution and page layout.
Other features include an easy to use fax scheduler that allows you to set up a date and time to 
transmit your fax. Cover page options are also provided. You can include a customized cover 
page with your fax transmission that can include sender and recipient fax information and a 
detailed message. You can easily maintain sender and contact information that can be printed 
on the cover pages.

Faxing hard-copy documents must be performed as a walk-up function from the Touch Panel 
Display.

Address Book Viewer
With the Address Book Viewer you can easily add or modify fax recipient names, fax numbers, 
and Internet Fax address (e-mail address) to the Address Book. This utility allows you to man-
age recipients of the fax, select and display fax recipients from the Address Book, as well as 
recipient fax numbers and other contact information.
Additionally, Address Book Viewer allows you import or export address book data to or from 
other address book programs compatible to this equipment.





2.Installing Client Software

This section describes the instructions on how to install the client software for the network fax features.

Installing Network Fax Software............................................................................16
Overview ...........................................................................................................................................16
Installing the N/W-Fax Driver and Address Book Viewer ..................................................................17

Uninstalling the Network Fax Software.................................................................26
Repairing Client Software ......................................................................................28
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Installing Network Fax Software

This chapter includes procedures for installing software required to enable the fax printing and 
online address books for this equipment. It is recommended that you read these instructions in 
their entirety before beginning the installation process.

Overview
Before you can begin utilizing the network fax feature for this equipment, you must install the 
software using the Client Utilities CD-ROM provided. You will use the InstallShield client soft-
ware setup process. This section describes several ways to add N/W-Fax driver to user’s work-
stations. Prior to installing the N/W-Fax driver and Address Book Viewer, the administrator must 
install specific hardware and configure the fax options. Only authorized users can modify the 
device.

System Requirements
The N/W-Fax driver and Address Book Viewer are available for following environments:

Display Resolution
1024 x 768 dots or more
Display Color
High Color (16bit) or higher is recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS
OS
Windows 98 (Windows 98 Second Edition Recommended)
Windows Me
Windows NT 4.0 Service Pack 6a
Windows 2000 Service Pack 4
Windows XP Service Pack 1/Service Pack2
Windows Vista
Windows Server 2003

Before Installing Client Software
Before installing the client software, confirm the following to perform an appropriate installation.

— When N/W-Fax Driver and Address Book Viewer Has Been Installed
If the N/W-Fax Driver and Address Book Viewer has been installed from either the e-
STUDIO451c Series Client Utilities CD-ROM, e-STUDIO850 Series, e-STUDIO853 Series Cli-
ent Utilities CD-ROM, e-STUDIO4511 Series Client2 CD-ROM, e-STUDIO450 Series, e-
STUDIO453 Series Client2 CD-ROM, or e-STUDIO280 Series, e-STUDIO283 Series Client2 
CD-ROM, you do not have to install it again.
If you want to install N/W-Fax Driver and Address Book Viewer from this CD-ROM, uninstall the 
existing N/W-Fax Driver and Address Book Viewer then reinstall it using this Client Utilities CD-
ROM.  When you uninstall the Address Book Viewer, please click [No] at the dialog box that dis-
plays the message to delete the settings for the Address Book Viewer so that you can restore 
the settings after installing the new Viewer.
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Installing the N/W-Fax Driver and Address Book Viewer
You can install the N/W-Fax driver and Address Book Viewer from the Client Utilities CD-ROM or 
TopAccess.
This section describes the installation of the N/W-Fax driver and Address Book Viewer in an 
SMB environment.  The  N/W-Fax driver can be set up using the same connection as a printer 
driver such as Parallel printing*, USB printing, LPR printing, IPP printing, and Novell printing.  To 
set up the N/W-Fax driver using these connections, please refer to the Printing Guide.
* AddressBook Viewer cannot obtain the address book data if it is connected via a parallel* or USB port.
* e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282 and e-STUDIO203L/233/283 do not 

support this function.

Installing from Client Utilities CD-ROM
This section describes how to install the fax client software in an SMB environment which is 
available for a local area network using TCP/IP.

To set up the N/W-Fax driver in other connections, please refer to the Printing Guide.
Before installing the printer driver in an SMB environment, confirm the following:
- This equipment is connected to the network and turned on.
- The TCP/IP setting is correct on this equipment and your computer.

Installing the fax client software for SMB printing using the installer

The following describes an installation on Windows XP. The procedure is the same when other 
versions of Windows are used.

You must log into Windows as a user who has the “Administrators” or “Power Users” privi-
lege.  You must log into Windows as a user who has the “Administrators” privilege when 
using Windows XP/Vista/Server 2003.
Only users with the administrator privilege can perform this on Windows Vista.For users 
without the administrator privilege, installation on Windows Vista is possible by performing 
the following procedure and having the administrator privilege temporarily.
- Select “Open folder to view files” in the AutoPlay menu and click [OK].
- Open the e-STUDIO folder, click “SetupLauncher.exe” and then select “Run as adminis-

trator”.
- Enter the administrator's password of the client computer to operate with an administra-

tor's privilege and click [OK]. 

1 Insert the Client Utilities CD-ROM into the CD-ROM drive.
If the installer does not automatically start, use the Explorer to open the e-STUDIO 
folder in the Client Utilities CD-ROM and double-click “SetupLauncher.exe.”
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2 Select “I agree to the terms of the License Agreement.” and click 
[Next].

To change the display language, select a desired language from the Select Language 
drop-down menu.
The main menu window is displayed.
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3 Select a menu; to install the fax driver, select “Recommended,” “N/
W-Fax Driver,” or “Custom Install.”

Recommended: Select this to install all the drivers and utilities included in the CD ROM. 
If you select this menu, skip to Step 5.
N/W-Fax Driver: Select this to install the network-fax driver and AddressBook Viewer 
only. If you select this menu, skip to Step 5.
Custom Install: Select this if you would like to pick and choose the installation 
components. If you select this menu, proceed to Step 4.

In addition to the above menus, the main menu window has the Printer Driver and the 
Scan Driver and Utility menus. For more information about these drivers and utilities, 
please see the Printing Guide, the Scanning Guide, and the e-Filing Guide.
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4 If you have selected “Custom Install” in Step 3, check the software 
that you want to install and click [Next].

The following software can be installed:
TOSHIBA e-STUDIO N/W-Fax
TOSHIBA e-STUDIO AddressBook Viewer

There are also printing software, scan software, and e-Filing software in the list. For more 
information about each software, please see the Printing Guide, the Scanning Guide, 
and the e-Filing Guide.

5 Confirm the list of the software to install and click [Install].

If you install AddressBook Viewer and/or File Downloader, you can change the folder 
where these programs are installed. Click [Browse] and, when the Browse For Folder 
dialog box appears, select a folder and click [OK].
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6 When the equipment is automatically found in the network, the 
“Devices on Network” option is selected and the found devices are 
displayed in the list. Select the equipment that you want to connect 
and click [OK].

The installation starts.

Finding devices may take long depending on your OS or network environment.
If the following message appears, click [Continue Anyway] to proceed with the instal-
lation.

When the equipment is not automatically found in the network, the “Message” dialog box 
appears. In that case, follow the procedure below to select the network queue manually.
1. On the “Message” dialog box that appears, click [Continue].
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2. Click [Browse] for the network path or queue name.

- Finding devices may take long depending on your OS or network environment.
3. The Browse for Folder dialog box appears. Locate this equipment in your network, 

select the “print” queue, and click [OK].

- Do not select “pcl6” or “ps3” queue. These queues only accept the print job in 
each emulation. If you install several printer drivers and specify one of these 
queues, the print job may not be printed properly due to mismatch of the emula-
tions between the print job and queue.
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4. Click [OK].

If the following message appears, click [Yes] to set the indicated printer driver to be the 
default printer driver, or click [No] to not change the default printer driver.

7 When the installation is complete, click [Finish].

The main menu window is displayed.

The Installer may ask you to restart your computer. If it does, select “Yes, I want to restart 
my computer now.” and click [Finish] to restart your computer.
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8 Click [Exit].
When a message appears asking whether to finish the installation, click [OK].

Installing from TopAccess
If the system administrator has uploaded the software to this equipment, you can use TopAc-
cess to install the software on your workstation.

When using Windows Server 2003 that the Service Pack is installed, the installation from 
TopAccess cannot be performed.  In that case, please install the software in the other 
method.
For instructions on how to upload the software in the equipment, please refer to the TopAc-
cess Guide.

Installing client software from TopAccess

1 In TopAccess, click the Install Software link at the bottom of the 
screen.

The Install Client Software page opens.
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2 Click the “Install Client1” link to download the installer file.

3 Download the installer file on your desktop by following the 
prompts.

4 Double-click the “InstallClient1.exe” file that you downloaded.
The installer starts and the InstallShield Wizard dialog box appears.

5 Follow the installation procedure using the Client Utilities CD-ROM 
described in following section.

 P.17 “Installing from Client Utilities CD-ROM”
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Uninstalling the Network Fax Software

The following instructions describe how to uninstall the N/W-Fax driver and Address Book 
Viewer.

 P.26 “Deleting the N/W-Fax driver”
 P.27 “Deleting Address Book Viewer”

Deleting the N/W-Fax driver

1 Open the “Printers” or “Printers and Faxes” folder, select the 
printer icon that you want to delete, and press the [Delete] key.

When using Windows 98/Me or Windows NT 4.0, uninstallation has finished.
When using Windows 2000/XP/Vista/Server 2003, continue to the next step.
When using Windows Vista, click the [Delete] in the Organize tab.

2 Click the [File] menu and select [Server Properties].

The Print Server Properties dialog box appears.
When you are using Windows Vista, follow the procedure below.
1. Right click in the blank area in the “Printers” window and click [Run as administra-
tor] and then [Server Properties] in the menu displayed.
2. When “Windows needs your permission to continue” appears, click [Continue].
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3 Display the Drivers tab.  Select the N/W-Fax driver and click 
[Remove].

The confirmation dialog box appears.
When you are using Windows Vista, follow the procedure below after selecting 
[Remove]:
1. Select “Remove driver and driver package” and click [OK] in the “Remove Driver 
And Package” dialog box.
2. Click [Yes] in the “Print Server Properties ” dialog box.
3. When “Driver package information collected” appears, click [Delete]
4. When “Driver package was removed” appears, click [OK] This is the end of the 
procedure for Windows Vista.

4 Click [Yes].

The N/W-Fax driver is completely deleted.

Deleting Address Book Viewer

You can uninstall Address Book Viewer in much the same way as uninstalling other utility soft-
ware, such as e-Filing client utilities – from Control Panel > Add or Remove Programs, select the 
software you want to delete. For details, see “Uninstalling e-Filing Client Software” in the e-Fil-
ing Guide.
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Repairing Client Software

When the client software will not work correctly, you can repair the client software.

Do not perform preparing the client software on Windows XP that the Service Pack 2 is not 
installed.  In that case, uninstall the client software and then install again to repair the client 
software.
N/W-Fax Driver cannot be repaired. Delete the software and install it again.

Repairing AddressBook Viewer

You can repair Address Book Viewer in much the same way as repairing other utility software, 
such as e-Filing client utilities – open the CD-ROM with Explorer, double-click the “Setup.exe” 
file to start the installer, and select “Repair.” For details, see “Repairing Client Software” in the e-
Filing Guide.
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Faxing from Applications

You can use the N/W-Fax driver option to electronically fax and Internet Fax from your computer 
to one or more recipients.
In addition, you can select fax properties, fax schedule options, include fax cover sheets and edit 
sender information.

Faxing hard-copy documents must be performed as a walk-up function from the Touch Panel 
Display.
Fax transmission using the N/W-Fax driver is available only when the optional Fax unit is 
installed.  Internet Fax transmission using the N/W-Fax driver is available without the 
optional Fax unit.

How to Fax using the N/W-Fax Driver
The following outline summarizes the steps for sending a fax from your desktop:

Create a document.
Print to Fax Driver.
Add recipient’s name and fax numbers.
Select a default cover page (optional).
Send the fax.

Preparing Documents for Faxing
To see how objects, such as headers, footers, or drawing objects, will be positioned on a fax 
page, switch to your applications’ page layout view. If the software application you are using pro-
vides a Print Preview option, you can use it to view your fax before it is sent.

Faxing from Windows Applications
Once you have installed the N/W-Fax driver, you can send the document directly from most Win-
dows applications as a fax or Internet Fax.
You can print using various functions by setting print options on the printer driver.

When you want specify the recipients using the Address Book Viewer, add the contacts in 
the Address Book Viewer first.

 P.55 “Managing Address Book”
You can specify up to 400 recipients at a single operation.  Moreover, you can send the doc-
ument to faxes and Internet Faxes at a same time.   However, if the cover page is set to be 
send or the header page is set to be printed on the recipient’s devices, all recipient’s 
addresses will be printed.  If you want to secure the recipient information, send the Internet 
Fax separately to each recipient rather than sending to the multiple recipients at the same 
time.

For e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282, e-STUDIO203L/233/283, e-
STUDIO520/600/720/850 and e-STUDIO523/603/723/853, fax transmission using the N/W-
Fax driver is available only when the printer kit or the printer/scanner kit is installed. 
For e-STUDIO352/452, e-STUDIO353/453, e-STUDIO202L/232/282, e-STUDIO203L/233/283, e-
STUDIO520/600/720/850 and e-STUDIO523/603/723/853, internet fax transmission using the 
N/W-Fax driver is available only when the printer kit and scanner kit are installed or the 
printer/scanner kit is installed. 
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Faxing from Windows applications

1 Open a file and select [Print] from the [File] menu of the application.
The Print dialog box appears.

2 Select “TOSHIBA e-STUDIO Series Fax” and Click [Properties].

The properties dialog box appears.

The procedures for displaying the properties dialog for the printer driver may be different 
depending on the application you are using. See your application’s manual about dis-
playing the printer properties dialog box.

3 Display the Send tab and specify the recipients, and other options.

You must specify the recipients to send a document as a fax.  For instructions on how 
to specify the recipients, see the following section.

 P.34 “Specifying Recipients”
For other settings on the Send tab, see the following section.

 P.45 “Setting the Send Properties”
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4 When you want to send a document with a fax cover sheet, display 
the Cover Sheet tab, select the cover sheet type in the “Cover 
Sheet” drop down box and specify the other options.

If you enable the “Sender Information” option, continue to the next step and specify 
the message to appear as the sender information.  Otherwise, skip to step 6.

For instructions on how to set the Cover Sheet tab, see the following section.
 P.47 “Setting up the Cover Sheet Properties”
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5 When you enable the “Sender Information” option in the Cover 
Sheet tab, display the Sender Information tab and enter the sender 
information message to appear the message on the fax cover 
sheet.

In the text field in the Sender Information tab, up to 500 characters can be entered.

For instructions on how to set the Sender Information, see the following section.
 P.48 “Setting up the Sender Information Properties”

6 Click [OK] to save the settings.

7 Click [OK] or [Print] to send a document.

You can monitor and manage the fax job that is sent from your computer using TopAc-
cess.

 P.53 “Managing Fax Jobs using TopAccess”

When you use the N/W-Fax driver to send a fax job, check whether the job has been suc-
cessfully sent, on the “Log - Send” screen in TopAccess.  If the relevant fax job is not 
included in the Log list, your transmission job may not have been performed.  In this 
case, search for jobs without the department code in the “Job status - FAX” on the control 
panel.  Then, select the relevant fax job and press the [SEND] button to resend it.
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Specifying Recipients
You can specify the recipients following method:

 P.34 “Specifying recipients from Address Book”
 P.38 “Searching recipients from address book”
 P.42 “Entering a recipient manually”

Also you can remove the recipients added to the “To” list.
 P.43 “Removing recipients”

Specifying recipients from Address Book

1 Click [Select From Address Book] in the Send tab.

The Address Book Viewer is launched.
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2 Browse the address book category within the Address Book where 
desired recipients are programed.

Private Address Book — This contains the contacts registered in the associated client 
address book on your client computer.
Public Address Book — This contains the contacts registered in the address book in 
this equipment.
MAPI Address Book — This contains the contacts in the address book of the default 
mail client in your computer. The display varies depending on the type of Microsoft mailer 
which you use.
MS Outlook Address Book — This contains the contacts in the MS Outlook Express 
address in your client computer.
LDAP Address Book — This contains the contacts in the specified LDAP server.
Import Address Book — If the address book data has been imported from a CSV file or 
vCard file, this address book will be displayed.

For more information about the Address Book Viewer, please refer to the Address Book 
Viewer Online Help.
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3 Select the contact you want to add as a recipient and click the [Fax] 
icon ( ) in the tool bar to add the fax number as a recipient, and 
click the [Mail] icon ( ) to add the e-mail address as a recipient.

Repeat until all required recipients are selected.
When you select the fax number as a destination, the fax number icon in front of the 
name of the contact will be changed to the checked fax icon ( ).
When you select the e-mail address as a destination, the e-mail icon in front of the 
name of the contact will be changed to the checked e-mail icon ( ).

You can cancel selecting the fax number or e-mail by selecting the contact and re-
clicking the [Fax] or [Mail] icon in the tool bar.
You can also select the recipient’s fax number by right-click the contact and select 
[Select] and [Fax Number] in the menu displayed.
You can also select the recipient’s e-mail address by right-click the contact and select 
[Select] and [EMail] in the menu displayed.
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4 After you selected all recipients,  right-click on a recipient name in 
the right pane and select [Selection] in the menu displayed.

The Destinations dialog box appears.

You can also display the Destinations dialog box by clicking the [Selection] icon ( ) in 
the tool bar.

5 Confirm the destinations that you select in the dialog box.  If you 
wish to remove a destination from the recipients list, select the con-
tact and click [Remove].

6 After you confirm the destinations, click [OK].
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7 The Address Book Viewer is closed and selected recipients are 
added to the “To” list.

Searching recipients from address book

1 Click [Select From Address Book] in the Send tab.

The Address Book Viewer is launched.
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2 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

3 Select a address book to search contacts in the “Data Source” drop 
down box.

The default address book in the “Data Source” can be set by selecting [View] - [Default 
Configuration] - [Data Source] from the menu bar.
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4 Display the Person tab and enter search text in the following fields 
that you require.

Name — Enter the search characters or string to search by the first name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact e-mail address.

You must enter one of the field to search contacts.  It will search the contacts that have 
exactly same name, fax number, or e-mail address as the entered search strings.

If you want to clear entered values, click [Clear All].

5 Click [Search].
It begins searching contacts in the selected address book.  When it completes 
searching, found contacts appear in the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].

6 Select the searched contacts and click [Address].

The Type Selection dialog box appears.
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7 Check the “Email Address” check box if you want to add the Email 
address of the selected contacts as the destinations, and check the 
“Fax Number” check box if you want to add the fax number of the 
selected contacts as the destinations.

The default destination type in the “Type Selection” dialog box can be set by selecting 
[View] - [Default Configuration] - [Type Selection] from the menu bar.

8 Click [OK].
The Destinations dialog box appears.

9 Click [OK].

The selected contacts are added as recipients for N/W-Fax.
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10 The Address Book Viewer is closed and selected recipients are 
added to the “To” list.

Entering a recipient manually

1 Click [New].

The Direct Dial dialog box appears.

2 To add an Internet Fax address as a recipient, select “Internet Fax 
Address” and enter the e-mail address of the recipient in the right 
field.
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To add a fax number as a recipient, select “Fax Number” and enter 
the fax number in the right field.  In addition, if you specify a Sub 
address, enter the Sub address in the “SUB” field, and security 
password for the Sub address in the “PWD” field if required.

You can send to a fax number only when the optional Fax unit is installed.
Use “-”(hyphen) if you send from the N/W-Fax and want to insert pauses in the Fax 
number.

3 Click [OK].
Entered recipient is added to the “To” list.

Removing recipients

1 Select a recipient that you want to delete from the “To” list.

2 Click [Remove].
The selected recipient is deleted from the “To” list.
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How to Setup
There are several ways to set the N/W-Fax driver options.  Also, how the settings effect varies 
depending on the way you set the options.

Setting Initial Values of N/W-Fax Driver Options
Setting the N/W-Fax options by displaying the N/W-Fax driver properties from the Printers folder 
within the Windows Start menu will establish the initial values of the options.

How to display: Windows XP/Vista/Server 2003

1 Click [Start] and select [Printers and Faxes].
When using Windows Vista, click [Start], [Control Panel] and select [Printers].

2 Select the N/W-Fax driver, click the [File] menu and select [Printing 
Preferences].

How to display: Windows NT 4.0/2000

1 Click [Start], [Settings], and select [Printers].

2 Select the N/W-Fax driver, click the [File] menu and select [Docu-
ment Defaults].

How to display: Windows 98/Me

1 Click [Start], [Settings], and select [Printers].

2 Select the N/W-Fax driver, click the [File] menu and select [Proper-
ties].

Setting Print Options for Each Print Job
Setting the N/W-Fax driver options by displaying the printer properties from the Print dialog box 
within an application will establish the values for the current N/W-Fax job. The N/W-Fax driver 
option settings specific to each N/W-Fax job are set using this method.

How to display:

1 Click the [File] menu and select [Print] on an application.

2 Select “TOSHIBA e-STUDIO Series Fax” and Click [Properties].
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Setting up the N/W-Fax Options
N/W-Fax options are the attributes you set to define the way a fax job is transmitted.  For exam-
ple, you can specify the recipients, resolution, and paper size.

For additional instructions concerning these fax transmission settings, refer to the procedures in 
the following section.

 P.49 “Sending with Extended Fax Functionality”

Setting the Send Properties
In the Send tab of the N/W-Fax properties dialog box, you can specify the recipients and how the 
fax will be sent.

To specify the recipients, you can select from the Address Book or enter the recipient manually.
 P.34 “Specifying Recipients”

1) To
This displays the specified recipients list.

2) [Select From Address Book]
Click to launch the Address Book Viewer. You can select recipients from the Address Book.

 P.34 “Specifying recipients from Address Book”

To use the Address Book, you must register the contacts using the Address Book Viewer.
 P.55 “Managing Address Book”
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3) [New]
Click to add new recipient by entering manually.  The Direct Dial dialog box appears.

 P.42 “Entering a recipient manually”

4) [Remove]
Select a recipient in the “To” list and click this to remove the recipient from the list.

 P.43 “Removing recipients”

5) Resolution
Select the resolution for the fax.
- Standard (200 x 100 dpi) — Select this to send a document in Standard mode (200 x 

100 dpi).
- Fine (200 x 200 dpi) — Select this to send a document in Fine mode (200 x 200 dpi).
- Super Fine (200 x 400 dpi) — Select this to send a document in Super Fine mode (200 

x 400 dpi).
- Ultra Fine (400 x 400 dpi) — Select this to send a document in Ultra Fine mode (400 x 

400 dpi).

6) Dept. Code
Enter 5-digit department code if required.  When the department code is enabled on this 
equipment, you must enter the department code to send a fax.

If you do not enter the department code when the department code is enabled on the 
equipment and the Department Code Enforcement is set to OFF in TopAccess, the job 
will be stored in the Invalid job list without transmitting the job.  You can release or delete 
the job that is stored in the Invalid job list from the [JOB STATUS] button on the Control 
Panel.  For instructions on how to release or delete the job in the Invalid job list, see 
Operator’s Manual for Basic Functions.
If you do not enter the department code when the department code is enabled on the 
equipment and the Department Code Enforcement is set to PRINT in TopAccess, the job 
will be sent.
If you do not enter the department code when the department code is enabled on the 
equipment and the Department Code Enforcement is set to DELETE in TopAccess, the 
job will be deleted automatically.

7) Paper Size
Select the paper size of your document.

8) Orientation
Select the orientation of your document.

9) Save as File
Select this to save up to 10GB documents in the "FILE_SHARE" folder in the equipment as 
well as send the document as a fax and Internet Fax.

 P.49 “Saving a Fax as File”

When the Cover Sheet is set, the Cover Sheet and the original will be stored in the 
“FILE_SHARE” folder.

10)File Format
Select the file format of the document that will be saved.  This option can be selected only 
when the “Save as File” box is checked.

11) Delayed Fax
Select whether sending a document now or later.
- Send Fax Now — Select this to send a document immediately.
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- Send Fax Later — Select this to send a document on a specified date and time.  When 
this is selected, click [Edit] to display the Scheduled Time dialog box and specify the date 
and time the job will be transmitted.  The job sent to this equipment will be stored in the 
Fax queue until the specified date and time.

 P.50 “Sending a document on specific date and time”

Setting up the Cover Sheet Properties
In the Cover Sheet tab of the N/W-Fax properties dialog box, you can specify the fax cover sheet 
to be sent.  If you enable the cover sheet, the cover sheet is attached in the first page of the doc-
ument and sent to the recipients.

 P.51 “Preparing the cover sheet”

1) Cover Sheet
Select the cover sheet type from “Standard Cover Page”, “Business Cover Page”, and “Pro-
fessional Cover Page”.  For cover sheet samples, see the Appendix at the end of this guide.

2) Font Name
Select the font to be used for the cover sheet.

3) Subject
Enter the subject to appear on the cover sheet.  You can enter up to 40 characters.

4) Message
Enter the message to appear on the cover sheet.  You can enter up to 500 characters.

5) Sender Information
Check this to print sender information on the cover sheet.  When this is enabled, specify the 
sender information in the Sender Information tab.

 P.48 “Setting up the Sender Information Properties”

6) Recipient Information
Check this to have recipient information appear on the cover sheet.  Select one or more of 
the following options to determine what information will appear in the “To:” field of the cover 
sheet.
- Name — Check this to have the recipient name appear on the cover sheet.
- Company — Check this to have the recipient company name appear on the cover sheet.

1

2

3

4

6

5

7



3 Faxing from Client Computers

48    Faxing from Applications

- Department Name — Check this to have the recipient department name appear on the 
cover sheet.

- Fax Number — Check this to have the recipient fax number or Internet Fax address 
appear on the cover sheet.

7) Reference Number
Enter the reference number to identify the fax.  This number will appear on the cover sheet.

Setting up the Sender Information Properties
In the Sender Information tab of the N/W-Fax properties dialog box, you can specify the sender 
information that appears on the cover sheet.  This must be set only when the “Sender Informa-
tion” box in the Cover Sheet tab is checked.
In the text field in the Sender Information tab, you can enter the up to 500 characters.
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Displaying the Version Information
In the About tab of the N/W-Fax properties dialog box, you can display the version information of 
the N/W-Fax driver.

Sending with Extended Fax Functionality
The N/W-Fax driver allows users to perform the following features.

 P.49 “Saving a Fax as File”
 P.50 “Delayed Transmission”
 P.51 “Sending with a Cover Sheet”

Saving a Fax as File
You can save a document in the “TXFAX” folder in the “FILE_SHARE” folder in this equipment 
as well as sending the document to fax numbers and Internet Fax addresses.

Saving a fax to the default box

1 Display the Send tab and check the “Save as File” box.

2 Select the file format in the “File Format” drop down box.
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3 Specify the other options to send a document and click [OK].

4 Click [Print] to send a document to this equipment.
The document is saved in the “TXFAX” folder in the “FILE_SHARE” folder in this 
equipment.

The saved file contains the cover sheet when the cover sheet is set.

Delayed Transmission
When the delayed transmission is specified, the fax is stored in the fax queue in this equipment 
and will be sent on the specified date and time.

Sending a document on specific date and time

1 Display the Send tab and select “Send Fax Later” in the “Delayed 
Fax” drop down box.

2 Click [Edit].
The Scheduled Time dialog box appears.

3 Select the date and time and click [OK].

You can click the Date arrow to display a calendar then allows you to select an date.
Enter the time to commence the fax transmission. You can use the up and down 
arrows to assist with setting the time with the proper format.

The scheduled date cannot be more than one month from the current date.  If the current 
month does not have a date like the current date, then the date will be set at the last day 
of the following month. For example, if the current date is March 31st. then the maximum 
date that can be selected for the scheduled fax is April 30th.

4 Specify the other options to send a document and click [OK].

5 Click [Print] to send a document to this equipment.
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Sending with a Cover Sheet
You can choose to send a cover sheet with your fax transmission. The cover sheet is merged 
with the recipient “To” list data to create a fax cover sheet. You can select what to include on the 
cover sheet such as sender or recipient information.

Preparing the cover sheet

1 Display the Cover Sheet tab and select the cover sheet type in the 
“Cover Sheet” drop down box.

For samples of the cover sheets, see the Appendix at the end of this guide.
 P.112 “Cover Sheet Samples”

2 Select the font in the “Font Name” drop down box.

The selected font applies to the text contents in the cover sheet.

3 Enter the subject to appear on the cover sheet in the “Subject” 
field.

You can enter up to 40 characters for the subject.

4 Enter the message to appear on the cover sheet in the “Message” 
field.

You can enter up to 500 characters for the message.
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5 If you want the sender information to appear on the cover sheet, 
check the “Sender Information” box.

If you check this, click the Sender Information tab and enter the sender information in 
the text box.  You can enter up to 500 characters in the sender information text box.

6 If you want the recipients information to appear on the cover sheet, 
check the “Recipients Information” box and check the items 
required for the recipient information.

Name — Check this to have the name of the recipient appear on the cover sheet.
Company — Check this to have the company name of the recipient appear on the cover 
sheet.
Department Name — Check this to have the department name of the recipient appear 
on the cover sheet.
Fax Number — Check this to have the fax number or Internet Fax address of the 
recipient appear on the cover sheet.

Recipients information is obtained from the address book.  If the recipient is added 
manually, this information does not appear on the cover sheet except for the fax num-
ber or Internet Fax address.
The recipients information for all recipients will appear on the cover sheet.

7 If you want the reference number to identify the document to 
appear on the cover sheet, check the “Reference Number” box and 
enter the reference number in the field.

You can enter up to 20 characters for the reference number.

8 Specify the other options to send a document and click [OK].

9 Click [Print] to send a document to this equipment.
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Managing Fax Jobs using TopAccess

You can display manage the fax jobs using TopAccess.
 P.53 “Managing Fax Jobs using TopAccess”

Managing Fax Jobs using TopAccess
Users can use TopAccess to display the fax jobs that are currently on this equipment. The Fax/
Internet Fax menu page in the Jobs tab allows the users to display and delete fax jobs that are 
currently stored in the queue.

Displaying and deleting the fax jobs using TopAccess

1 Access TopAccess using the browser.
For the instruction to access TopAccess, please refer to the TopAccess Guide.

2 Click the Job Status tab and Fax/Internet Fax menu.

The Fax/Internet Fax menu page displays the list of fax jobs.

3 If you want to delete a fax job, select a option box of the fax job in 
the list, and click [Delete].

The selected fax job is deleted.
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Running Address Book Viewer

The Address Book Viewer allows you to manage the Address Book properties, manage address 
books and address book entries. Particularly, you can perform the following functions:

Create new contacts
Create Address Book groups
Modify contact information
Search the address book database
Import Address Book data
Export Address Book data

Running the Address Book Viewer
You can access the Address Book Viewer using two methods:

Programs folder in the Start menu
Print Properties window of the N/W-Fax driver (limited accessibility)

Access Using Program Group
From the Program Group, you can access the Address Book Viewer to create and edit your pri-
vate address book.

Accessing the Address Book Viewer from the Programs group

1 Click the [Start] menu, select [All Programs], [TOSHIBA 
e-STUDIO Client], and select [TOSHIBA e-STUDIO 
AddressBookViewer].

The Address Book Viewer window appears.
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Access Using Print Properties
Within the application Print window, you have a limited ability to create and edit contacts in the 
Address Book. 

This method is only suggested if you are in the process of sending a fax and you need to add a 
fax recipient to the send list that is not currently a member of the Address Book. Otherwise, use 
the program group to access the Address Book Viewer.

Accessing the Address Book Viewer from the Print properties

1 In the Print dialog box in the application, select the N/W-Fax driver 
for the printer and click [Properties].

The N/W-Fax properties dialog box appears.

2 Click [Select From Address Book] in the Send tab.

The Address Book Viewer window appears.
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— Selecting Contacts for N/W-Fax
When you access the Address Book Viewer from the N/W-Fax driver, it allows you to select the 
contacts from the Address Book Viewer.
After you select contacts that you want to add as recipients, right-click on a recipient name in the 
right pane and select [Selection] in the context sensitive menu.

You can also select the recipients by searching the contacts in the Address Book Viewer.
 P.96 “Searching Contacts”

Then the Destinations dialog box appears.

[Remove] — Click this to remove the selected contacts from the destinations list.
[OK] — Click this to add these contacts as the destinations.
[Cancel] — Click this to cancel the selection.
[Help] — Click this to display the online Help.



Running Address Book Viewer    59

About Address Book Viewer Interface
The Address Book Viewer main window consists of following items.

1) Menu Bar
You can perform various functions by selecting a command from the menus.

 P.60 “Menu Bar”

2) Toolbar
You can perform general functions quickly by clicking an icon in the tool bar.

 P.62 “Toolbar”

3) Browse Pane
You can expand or collapse to view/hide Groups and Contact address book entries.
The browse pane contains a tree structure for the following address books:
- Private Address Book — This contains the contacts registered in the associated client 

address book on your client computer.
- Public Address Book — This contains the contacts registered in the address book in 

this equipment.
- MAPI Address Book — This contains the contacts in the address book of default mail 

client in your computer.
- MS Outlook Address Book — This contains the contacts in the MS Outlook Express 

address in your client computer.
- LDAP Address Book — This contains the contacts in specified LDAP server.
- Import Address Book — If the address book data has been imported from a CSV file or 

vCard file, this address book will be displayed.

4) Contents Pane
The right-hand pane displays non-modifiable, text-only summary information about the cur-
rently selected address book entry.  Selecting an entry in the browse pane of the address 
book displays summary information about the entry in the contents pane. 

5) Status Bar
This displays the description of selected command in the left side, and the number of the 
items of the currently selected address book entry in the right side.
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Using Commands
Address Book Viewer allows you to perform a wide variety of functions.
You can access all of the commands from menus in the menu bar and from the icons in the tool 
bar at the top of the Address Book Viewer window.  You can also choose commands from con-
text-sensitive menus by right-clicking the browse pane and contents pane.

Menu Bar
The menu bar contains five menus of commands that allow you to perform various functions in 
Address Book Viewer.

1) File menu
The following commands can be selected in the File menu.
- New Contact — Select this to add new contact in the private address book.  If the cur-

rently selected item is a group, the contact will be created as a member of the group.  If 
the currently selected item is the “Location/People” folder or “Private Address Book” 
object, the contact will be created in the "Location/People" folder.  This command is avail-
able only when selecting items in the object in the private address book.

- New Group — Select this to add new group in the private address book.  This command 
is available only when selecting the “Group” folder in the private address book.

- Properties — Select this to edit or display the properties of a group or a contact in the 
private or public address book.  This command is available only when selecting a group 
or a contact in the private or public address book.

- Delete — Select this to delete a group or contacts in the private address book.  This 
command is available only when selecting a group or contacts in the private address 
book.

- Devices — Select this to download the public address book from this equipment.
- Import -CSV File — Select this to import the address book data that had been exported 

as CSV files from e-STUDIO3510 Series, e-STUDIO451c Series, e-STUDIO850 Series, 
e-STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO453 
Series, e-STUDIO280 Series, e-STUDIO283 Series GL-1010 address book using the 
Address Book Viewer.  The data will be imported in the “Import Address Book”.

- Import -vCard File — Select this to import the address book data that had been 
exported as vCard files from e-STUDIO3510c Series, e-STUDIO451c Series, e-
STUDIO850 Series, e-STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 
Series, e-STUDIO453 Series, e-STUDIO280 Series, e-STUDIO283 Series GL-1010 
address book using the Address Book Viewer. The data will be imported in the “Import 
Address Book”.  This command is available only when Microsoft Office XP is installed on 
your computer.

- Export - CSV File — Select this to export the selected address book as a CSV file.
- Export - vCard File — Select this to export the selected address book as a vCard file.  

This command is available only when Microsoft Office XP is installed on your computer.
- Exit — Select this to exit the Address Book Viewer.

2) Edit menu
The following commands can be selected in the Edit menu.
- Copy — Select this to copy the selected contacts or a group in the clipboard.  The con-

tacts or a group copied in the clipboard can be pasted in the private address book.  This 
item is available only when selecting a group or contacts in any address book.

- Paste — Select this to paste the contacts or a group copied in the clipboard in the private 
address book.  If the group has been copied, this item is available only when selecting 
the “Group” folder.  If the contacts have been copied, this item is available only when 
selecting a group or the “Location/People” folder in the private address book.

- Select All — Select this to select all contacts displayed in the right pane.  This item is 
available only when browsing groups or contacts.
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- Find — Select this to find a contact by searching the address book.  You can also search 
the LDAP server to add the contacts in the LDAP Address Book.

3) View menu
The following commands can be selected in the View menu.
- Toolbar — Select this to display or hide the toolbar.  When the check mark appears in 

the menu, the toolbar is currently displayed.  You can select it again to hide the toolbar.
- Status Bar — Select this to display or hide the status bar.  When the check mark 

appears in the menu, the status bar is currently displayed.  You can select it again to hide 
the status bar.

- Large Icons — Select this to display the contacts using large icons.
- Small Icons — Select this to display the contacts using small icons.
- List — Select this to display the contacts in a list.
- Details — Select this to display the contacts in a list with detailed information.
- Sort By - Name — Select this to sort the contacts alphabetically by the name.
- Sort By - Fax Number — Select this to sort the contacts alphabetically by the fax num-

ber.
- Sort By - Email Address — Select this to sort the contacts alphabetically by the e-mail 

address.
- Sort By - Ascending — Select this to sort the contacts alphabetically in ascending order.
- Sort By - Descending — Select this to sort the contacts alphabetically in descending 

order.
- Default Configuration - Data Source — Select the address book that will be the default 

address book for the Find Contact dialog box. Select the address book from which you 
frequently search for the contacts.  The Public Address Book is set as the factory default.

- Default Configuration - Type Selection — Select the default destination type that will 
be enabled in the Type Selection dialog box, which appears when searching for the con-
tacts as the destinations of the N/W-Fax job.  You can select either “Fax Number”, “Email 
Address” or “Both” to set the default selection type.  The “Email Address” is set as the 
factory default.  This can be set only when the Address Book Viewer is launched from the 
N/W-Fax driver.

4) Tools menu
The following commands can be selected in the Tools menu.
- LDAP Setting — Select this to configure the LDAP service to obtain the LDAP address 

book from the LDAP server.
- Device Setting — Select this to find the device to obtain the public address book from 

this equipment.
- Convert for TopAccess — Select this to run the Address Book Converter.  Using the 

Address Book Converter, the address book file of the GL-1010 or GL-1020 that can be 
created using TopAccess can be converted to the address book file that can be restored 
or imported to e-STUDIO3510c Series, e-STUDIO451c Series, e-STUDIO850 Series, e-
STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-STUDIO453 
Series, e-STUDIO280 Series and e-STUDIO283 Series with TopAccess.  This command 
is available only for Windows NT 4.0, Windows 2000, Windows XP, and Windows Server 
2003.

To use "Convert for TopAccess", Java 2 Runtime Environment V1.4.2 or later must be 
installed.

5) Help
The following commands can be selected in the Help menu.
- Contents and Index — Select this to display the Online Help.
- About TOSHIBA e-STUDIO Address Book — Select this to display the version informa-

tion.
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Toolbar
You can use following tool icon to perform various functions quickly.

 (New Contact) — Click this to add a new contact in the private address book.  If the cur-
rently selected item is a group, the contact will be created as a member of the group.  If the cur-
rently selected item is a contact or the address book, the contact will be created in the address 
book.  This icon is available only when selecting items in the private address book.

 (New Group) — Click this to add a new group in the private address book.  This icon is 
available only when selecting the “Group” folder in the private address book.

 (Copy) — Click this to copy the selected contacts or a group in the clipboard.  The con-
tacts or a group copied in the clipboard can be pasted in the private address book.  This icon is 
available only when selecting a group or contacts in any address book.

 (Paste) — Click this to paste the contacts or a group copied in the clipboard in the private 
address book.  If the group has been copied, this item is available only when selecting a 
“Group” folder.  If contacts have been copied, this item is available only when selecting a group 
or "Location/People" folder in the private address book.

 (Properties) — Click this to edit or display the properties of a group or a contact.  This 
icon is available only when selecting a group or a contact.

 (Delete) — Click this to delete a group or contacts in the private address book.  This icon 
is available only when selecting a group or contacts in the private address book.

 (Find) — Click this to find a contact by searching the address book.

 (Download AB) — Click this to download the public address book that you modified to 
this equipment.

 (Fax) — Click this to add the fax numbers of selected contacts as destinations to be sent 
using the N/W-Fax driver.  This icon is available only when accessing the Address Book Viewer 
from the N/W-Fax driver properties dialog box and selecting contacts.

 (Mail) — Click this to add the e-mail addresses of selected contacts as destinations to be 
sent using the N/W-Fax driver.  This icon is available only when accessing the Address Book 
Viewer from the N/W-Fax driver properties dialog box and selecting contacts.

 (Confirm Selection) — Click this to display the Destinations dialog box to confirm the 
destinations to be sent using the N/W-Fax driver.  This icon is available only when accessing the 
Address Book Viewer from the N/W-Fax driver properties dialog box and any fax numbers or e-
mail addresses have been selected as destinations.
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Context-Sensitive Menus
You can also use the context-sensitive menu that is displayed by right-click an item displayed in 
Address Book Viewer window.

Add - Contact — Select this to add a new contact in the private address book.  If the cur-
rently selected item is a group, the contact will be created as a member of the group.  If the 
currently selected item is the "Location/People" or the private address book folder, the con-
tact will be created in the "Location/People" folder.  This command is available only when 
selecting items in the private address book.
Add - Group — Select this to add a new group in the private address book.  This command 
is available only when selecting the “Group” folder in the private address book.
Copy — Select this to copy the selected contacts or groups in the clipboard.  The contacts or 
groups copied in the clipboard can be pasted in the private address book.  This item is avail-
able only when selecting contacts or groups in any address book.
Paste — Select this to paste the contacts or groups copied in the clipboard in the private 
address book.  This item is available only when selecting a group or the “Location/People” 
folder in the private address book.
Properties — Select this to edit or display the properties of a contact or group.  This com-
mand is available only when selecting a contact or group.
Delete — Select this to delete the selected contacts or groups in the private address book.  
This command is available only when selecting contacts or groups in the private address 
book.
Select - Fax Number — Select this to add the fax numbers of selected contacts or groups 
as destinations to be sent using the N/W-Fax driver.  This item is available only when 
accessing the Address Book Viewer from the N/W-Fax driver properties dialog box and 
selecting contacts or groups.
Select - EMail — Select this to add the e-mail addresses of selected contacts or groups as 
destinations to be sent using the N/W-Fax driver.  This item is available only when accessing 
the Address Book Viewer from the N/W-Fax driver properties dialog box and selecting con-
tacts or groups.
Selection — Select this to display the Destinations dialog box to confirm the destinations to 
be sent using the N/W-Fax driver.  This item is available only when accessing the Address 
Book Viewer from the N/W-Fax driver properties dialog box and fax numbers or e-mail 
addresses have been selected as destinations.
Export to vCard — Select this to export the selected contact as a vCard file.  This command 
is available only when Microsoft Office XP is installed on your computer.
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Managing Address Book

You can use the Address Book Viewer to manage the private address book.  You can add or edit 
the contacts and groups as you desire.  The private address book data is stored in your client 
computer.  It can be used to manage the contacts and groups for sending a fax or Internet Fax 
using the N/W-Fax driver.
The Address Book Viewer also displays a public address book that is the address book in the 
compatible TOSHIBA equipment, such as e-STUDIO3510c Series, e-STUDIO451c Series, 
e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-
STUDIO453 Series, e-STUDIO280 Series, e-STUDIO283 Series and GL-1010 controller for the 
e-STUDIO35/45.  Using the Address Book Viewer, you can display the contacts or groups in the 
address book and they can be copied to your private address book.
In addition, you can access additional address book data such as the address book application 
of the default e-mail client in your computer, Microsoft Outlook Address Book, and an LDAP 
directory service running in your network.  You cannot add, delete, or edit the data in these 
address book, but you can copy their address book data to paste into the private address book.

About the Address Books
You can manage your address book using following address books:

Private Address Book can be used as your own address book.
 P.64 “Managing the Private Address Book”

Public Address Book allows you to display the address book in e-STUDIO3510c Series, e-
STUDIO451c Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO4511 Series, 
e-STUDIO450 Series, e-STUDIO453 Series, e-STUDIO280 Series, e-STUDIO283 Series 
and GL-1010 controller for the e-STUDIO35/45.

 P.65 “Managing the Public Address Book”
MAPI Address Book allows you to display the address book data of the default e-mail appli-
cation in your computer.

 P.71 “Configuring the MAPI Address Book”
MS Outlook Address Book allows you to display the address book data of Microsoft Outlook 
Express in your computer.

 P.71 “Managing the Microsoft Outlook Address Book”
LDAP Address Book allows you to display the address book data which is added from LDAP 
servers.

 P.71 “Managing the LDAP Address Book”

Also the Address Book Viewer allows users to import and export the address book data as CSV 
file or vCard file, so that users can import the CSV file or vCard file which exported from another 
user’s private address book or public address book, and users can export the private address 
book and public address book for other users.

 P.79 “Importing and Exporting the Address Book”

Importing and exporting a vCard file is available only when Microsoft Office XP is installed on 
your computer.
When you import or export a vCard file, only a single contact can be imported or exported.

Managing the Private Address Book
You can manage your own address book using the private address book.  You can add, delete, 
and modify the contacts in this address book.  You can also create, delete, and modify groups.
Contacts and groups can be added to this address book by various ways using other address 
books within the Address Book Viewer.  For instruction on how to manage the contacts and 
groups in the private address book, please refer to the following section:

 P.83 “Managing Contacts and Groups”
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Managing the Public Address Book
In order to access the public address book in e-STUDIO3510c Series, e-STUDIO451c Series, 
e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 Series, e-
STUDIO453 Series, e-STUDIO280 Series, e-STUDIO283 Series and GL-1010 controller for the 
e-STUDIO35/45, you must configure the connection to the device.
You can configure the connection by searching the device in the network, or entering the IP 
address of the device manually.

 P.65 “Configuring the Connection by Local Discovery”
 P.68 “Configuring the Connection by Manual Selection”

After configuring the connection to the device, the address book data of the device is obtained in 
the public address book.  You can display the address book data and copy them in the private 
address book.
For the instruction to download the public address book data into the Address Book Viewer, 
please refer to the following section:

 P.70 “Downloading the Public Address Book”

The address book in this equipment cannot be acquired using Address Book Viewer with the 
USB connected.
In the address book data, when the number of the addresses registered in the equipment 
exceeds 400 or when the total number of the data registered in each group exceeds 200, to 
download address book data into Address Book Viewer, the FTP Server option that can be 
set in the Network settings of TopAccess must be enabled.

— Configuring the Connection by Local Discovery
You can search the device in your network and configure the connection.

Discovering the device

1 Click the [Tools] menu and select [Device Setting].

The TopAccessDocMon Local Discovery dialog box appears.
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2 Click [Start Discovery] to begin the process.

It locates all the compatible devices in your network.

You can quit the process by clicking [Stop Discovery].
If the process continues for a long time, it is because the too many network clients are 
in the network.  In this case, you can configure the discovery settings from 
[Advanced] button.

 P.67 “Configuring Discovery Settings”

3 When the process completes, found printers are listed in the list.

4 Select the device that you want to access from the list and click 
[OK].

You can obtain the address book data by clicking Public Adress Book in the browse 
pane.
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Configuring Discovery Settings
You can configure the discovery settings.

Devices
Click the arrow button to display the pull down list and check the model name that you want 
to search.
Network - Enable IPX/SPX Search
This is disabled because the Address Book Viewer does not support the IPX/SPX connec-
tion.
Network - Enable TCP/IP Search
Check on this to search devices that connect to the TCP/IP network.  This is available only 
when the TCP/IP protocol is installed in your computer.
When this is enabled, select how it searches printers in the TCP/IP network.
- Search local subnet — Select this to search devices in local subnet.
- Specify a range — Select this to search devices in specific range of IP addresses.  

When this is selected, enter the IP addresses in “From” field and “To” field to specify the 
range.

- IPv4 — Select this to search devices set with an IPv4 address.
- IPv6 — Select this to search devices set with an IPv6 address.
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— Configuring the Connection by Manual Selection
You can configure the connection by entering the IP or IPX address of the device manually.

Configuring the connection manually

1 Click the [Tools] menu and select [Device Setting].

The TopAccessDocMon Local Discovery dialog box appears.

2 Click [Manual Selection].

The Manual Selection dialog box appears.
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3 Enter each item to specify the printer address.

IPv4 Address — Enter the IPv4 address of the printer.
IPv6 Address — Enter the IPv6 address of the printer.
IPX Address — This is disabled because the Address Book Viewer does not support the 
IPX/SPX connection.
Name — Enter the printer name.
Location — Enter the location of the printer.

You must enter “Name” and either “IP Address” or “IPX Address”.

4 Click [OK].
Entered device is added to the list in the TopAccessDocMon Local Discovery dialog 
box.

5 Select the entered device name and click [OK].

The Address Book Viewer connects to entered device and obtains the address book 
data in the Public Address Book.
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— Downloading the Public Address Book
You can download the address book data in the equipment to the Address Book Viewer.

In the address book data, if the number of the addresses registered in the equipment exceeds 
400 or when the total number of the data registered in each group exceeds 200, the Address 
Book Viewer downloads the address book data that are backed up in the equipment using 
TopAccess through FTP. Only the administrator can back up the address book data. If the 
address book data are old, ask your administrator to back up the address book data.

Downloading the public address book data

1 Click the [File] menu, select [Devices], and select the device name 
that you want to download the address book.

2 Select “Public Address Book” in the browse pane.

3 The Downloading dialog box appears.  You can quit downloading 
the address book data by clicking [Cancel].

The public address book data is downloaded from the selected device.
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Configuring the MAPI Address Book
The Address Book Viewer automatically accesses the address book application of the default e-
mail client software using the Messaging API (MAPI).
If the Address Book Viewer prompts an error message when selecting the MAPI Address Book, 
the default e-mail client software has not been defined in your computer, or the default e-mail 
software does not support MAPI.  In this case, set the MAPI-compliant e-mail software as the 
default e-mail client.  For instructions on how to set your e-mail application as default e-mail cli-
ent, refer to the documentation or online help of your e-mail application.
You can use the MAPI address book to copy the contacts and groups to the private address 
book.
Turn OFF the cache exchange mode before using it.

 P.86 “Copying Contacts from an Address Book”

The MAPI Address Book cannot be used on Windows XP x64, Windows Vista x64, or Windows 
Server 2003.

Managing the Microsoft Outlook Address Book
The Address Book Viewer automatically accesses the Microsoft Outlook Express Address Book 
to obtain the address book data.  You use the MS Outlook address book to copy the contacts 
and groups to the private address book.

 P.86 “Copying Contacts from an Address Book”

Managing the LDAP Address Book
In order to access to the address book data in the LDAP servers, first you must register the 
LDAP directory services that you want to access.

 P.72 “Registering the LDAP Directory Services”
Then search contacts in the LDAP server and add the contacts to the LDAP Address Book.

 P.74 “Adding Contacts from LDAP Servers”
You can use the LDAP address book to copy the contacts to the private address book.

 P.86 “Copying Contacts from an Address Book”
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— Registering the LDAP Directory Services
You can register multiple LDAP directory services.

Registering the LDAP directory services

1 Click the [Tools] menu and select [LDAP Setting].

The Internet Account dialog box appears.

2 In the General tab, enter the items as described below.

Directory Server Name — Enter the server name or IP address of a LDAP server.
This Server requires me to log on — Check this if the LDAP server requires the user 
name and password to log on.
Account Name — Enter the user name to log on the LDAP server.
Password — Enter the password to log on the LDAP server.
Log on using Secure Password Authentication — Check this to use secure password 
to log on the LDAP server.
Character code setting — Select the character code for the LDAP server.

In the Directory Server Name field, enter the IP address instead of the server name If the 
LDAP server name cannot be resolved.
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3 In the Advanced tab, enter the items as described below.

Server Port Number - Directory service (LDAP) — Enter the port number to access 
the LDAP server.  It shows “389” as a default.  Change this number if you are sure the 
LDAP port number is changed from the default port number on the LDAP server.
Server Port Number - This Server requires a secure connection (SSL) — Check this 
when you require to access the LDAP server using SSL.
Search - Search timeout — Select the timeout interval for searching.
Search - Maximum number of matches to return — Select maximum numbers for the 
search results.
Search - Search Base — Enter the search root suffix.

4 Click [Add].
The entered directory service is added to the Directory Service list.

5 Repeat the procedure from Step 2 to Step 4 until all required direc-
tory services are added.

6 Click [Close].
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— Adding Contacts from LDAP Servers
After you register the LDAP directory services, you can search contacts in the LDAP servers and 
add preferred contacts to the LDAP Address Book.
You can search contacts by the name, fax number, and e-mail address.  Also you can search 
contacts by specifying the detailed search conditions.

Searching contacts by name, fax number, and e-mail address

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop 
down box.
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3 Display the Person tab and enter search text in the following fields 
that you require.

Name — Enter the search characters or string to search by the contact name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact e-mail address.

You must enter data into one of the fields to search contacts.  It will search the contacts 
that contain the entered search strings.

If you want to clear entered values, click [Clear All].

4 Click [Search].
It begins searching contacts in the LDAP server.  When it completes searching, found 
contacts appears in the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].
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5 Select contacts that you want to add to the LDAP Address Book, 
and click [Add].

The selected contacts are added to the LDAP Address Book.

Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a registered directory service in the “Data Source” drop 
down box.
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3 Display the Detail Setting tab and select a field to search in the 
“Field Select” drop down box.

4 Select how it searches contacts in the “Condition of search string” 
drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

5 Enter the search string in the next field to the “Condition of search 
string” drop down box.

6 Click [Add].
Specified search condition is added to the condition list.

If you want to clear entered values, click [Clear All].



4 Managing Address Book

78    Managing Address Book

7 Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

You can remove the search conditions you have added.  To do this, select the condition 
and click [Delete].

8 Click [Search].
It begins searching contacts in the LDAP server.  When it completes searching, found 
contacts appear in the list at the bottom of the dialog box.

If you want to stop searching, click [Stop].

9 Select contacts that you want to add to the LDAP Address Book, 
and click [Add].

The selected contacts are added to the LDAP Address Book.
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Importing and Exporting the Address Book
The Export feature of the Address Book Viewer allows you to create a CSV file or vCard file of 
your selected address book, and it can be imported to other user’s Address Book Viewer.  The 
Import/Export feature is useful when users want to share the address book data.

The CSV file to import the Address Book Viewer must be created as the comma separated 
file in the following format:

For more information about the format, please contact your service engineer.
Importing and Exporting a vCard file is available only when Microsoft Office XP is installed on 
your computer.
When you import or export a vCard file, only a single contact can be imported or exported.

If any data is lost during importing, confirm the following:
- Both the First Name and Last Name are not blank.
- Both the E-mail address and Fax number are not blank.

Also you can use the import address book to copy the contacts and groups to the private 
address book.

 P.86 “Copying Contacts from an Address Book”

Group Name,Contact Key,Prefix,First Name,Last Name,Suffix,Display Name,Company Name,Department Name,First Fax 
Number,Second Fax Number,Email Address,Furigana,One Touch ID,Notes,Attenuation,Error Correction Mode,Fax Mode,Line 
Monitor,Line Selection,Option Type,Oversea Calls,Print Transmission Report,Short Protocol,Transmission 
Type,UseDeviceSettings,UseSubAddSID,Compression,PageWidth,Resolution,Password,SenderIdentification,SEP,SubAddress
,1,,User01,User,,User01 User,12345COMPANY,Dept01,00000000001,,user01@ifax.com,,1,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
,2,,User02,User,,User02 User,12345COMPANY,Dept02,00000000002,,user02@ifax.com,,2,,0,1,0,0,2,0,0,0,0,1,0,0,0,0,0,,,,
Group1,1,1,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
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Importing the address book from a CSV file or vCard file

Address book files that are exported from GL-1010 or GL-1020 using TopAccess cannot be 
imported to the Address Book Viewer.

1 Click the [File] menu and select [Import] and [CSV File] or [vCard 
File].

The Importing dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on 
your computer.
Even if you import a vCard file that contains multiple contacts, only a single contact 
can be imported.

2 Locate the folder where the CSV file or vCard file is stored, and 
select the file type (CSV or vCard) in the “Files of type” drop down 
box.  Then select the file and click [Open].
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3 The address book data is imported into “Import Address Book”.

If you have already been import an address book before, contacts information will be 
overwritten the existing import address book.

If one or more records have been skipped during the import process, it may be due to 
one of following reasons:
- Record already exists.
- Group name contains an invalid character.
- Fax number is invalid.
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Exporting the address book as a CSV file or vCard File

1 Click the [File] menu and select [Export] and [CSV File] or [vCard 
File].

The Exporting dialog box appears.

The [vCard File] command will appear only when Microsoft Office XP is installed on 
your computer.
The [vCard File] command can be selected only when you select an individual con-
tact.  Only a single contact can be exported.

2 Locate the folder where you want to save the CSV file or vCard File, 
enter the file name and click [Save].

The private address book is exported as a CSV file or vCard file.
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Managing Contacts and Groups
Users can create contact and group entries to the private address book that can be accessed 
from your desktop.
Under the Private Address Book folder, there are two containers, “Group” and “Location/Peo-
ple”.
The “Location/People” folder contains individual contact information.  The Group folder contains 
the groups and it can contain the individual contact information in each group.
Up to 200 groups in “Group”, 2000 contacts in “Location/People” and 2000 contacts in total of 
“Group” and “Location/People” can be registered.

Managing Contacts
You can add contacts to the “Location/People” folder and each created groups in the Private 
Address Book.
There are several ways to add the contact to the container.

 P.83 “Adding Contacts Manually”
 P.86 “Copying Contacts from an Address Book”

Also you can modify or delete contacts in the private address book.
 P.87 “Displaying or Modifying Contacts Properties”
 P.90 “Removing Contacts”

— Adding Contacts Manually
You can add new contacts to the “Location/People” folder in the private address book.  Also you 
can add new contacts to groups created in the private address book.

Adding a new contact manually

1 Select the folder that you want to add new contact in the left pane.

If you want to add new individual contact in the private address book, select the 
“Location/People” folder under “Private Address Book” folder.
If you want to add new contact to the group in the private address book, select a 
group that you want to add a contact in the “Group” folder under “Private Address 
Book” folder.
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2 Click the [File] menu and select [New Contact].

The New Contact dialog box appears.

3 In the Personal tab, enter items as described below.

One Touch ID — Select the one touch ID number for the contact (if desired).
Prefix — Select the prefix for the contact.
First Name — Enter the first name of the contact.  You can enter up to 32 characters.
Last Name — Enter the last name of the contact.  You can enter up to 32 characters.
Suffix — Select the suffix for the contact.
Display Name — The display name is automatically entered as “[Prefix] [First Name] 
[Last Name] [Suffix]”.  You can also edit the name as you prefer.  You can enter up to 80 
characters.
Company — Enter the company name of the contact. You can enter up to 64 characters.
Department — Enter the department name of the contact.  You can enter up to 64 
characters.
Fax — Enter the 1st fax number of the contact.  You can enter up to 128 characters 
includes numbers and the following symbols: +, -, [space], *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired 
point in the number.
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Second Fax — Enter the 2nd fax number of the contact.  You can enter up to 128 
characters includes numbers and the following symbols: +, -, [space], *, #
To add a 3 second pause to a fax telephone number, place a hyphen (-) at the desired 
point in the number.
E-mail Address — Enter the e-mail address of the contact.  You can enter up to 192 
characters.
Notes — Enter any notes for the contact.  You can enter up to 256 characters.

You must enter either “First Name” or “Last Name”, and either “Fax” or “E-mail Address”.

4 In the Sending Options tab, enter items as described below as 
required.

Use Sub Address and sender information — Check this to enable subaddress 
transmission for this contact.  When this is checked, documents will be always sent using 
the specified sub address and SID.  Also you can use this contact to perform polling 
transmission from the mailbox in the remote facsimile using the specified sub address 
and password.
Sub Address — Enter the sub address or mailbox number of remote facsimile where a 
document will be sent.  This can be entered only when “Use Sub Address and sender 
information” is enabled.
Sender Identification — Enter the security password for the sub address if required.  
This can be entered only when “Use Sub Address and sender information” is enabled.

Other items in this tab cannot be modified.

5 Click [OK].
The contact is added to the list in the selected folder.
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— Copying Contacts from an Address Book
You can also add contacts to the private address book by copying contacts from another 
address book folder.

Copying contacts from another address book folder

1 Browse to the folder that contains the contacts you want to copy, 
and select the contacts in the right pane.

2 Click the [Edit] menu and select [Copy].

The selected contacts are copied in the clipboard.

3 Browse the Private Address Book and select a folder that you want 
to add the copied contacts in the left pane.

If you want to copy individual contacts in the private address book, select the “Loca-
tion/People” folder under the “Private Address Book” folder.
If you want to copy contacts to the group in the private address book, select a group 
that you want to add contacts in the “Group” folder under the “Private Address Book” 
folder.

4 Click the [Edit] menu and select [Paste].

Copied contacts are added to the list in the selected folder.
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— Displaying or Modifying Contacts Properties
You can display the properties of contacts in any address book.  You can also edit the properties 
of contacts in the private address book.

Displaying or modifying the contact properties

1 Browse to the folder that contains the contacts you want to display 
or modify, and select the contact in the right pane.

2 Click the [File] menu and select [Properties].

The Properties dialog box appears.

You can also display the Properties dialog box by double-clicking the contact in the right 
pane.

In the Properties dialog box, you can modify the settings of the contacts in the private address 
book only.  When you display the Contact dialog box of the contacts in any other address books, 
you cannot modify the settings.
The Properties dialog box contains the Personal tab, Sending Options tab, and Security tab.

The tabs that will be displayed vary based on the type of the address book that the contact is 
chosen from.
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Personal Tab
In the Personal tab, following items are displayed:

When displaying the properties of a contact in the private address book, you can modify all 
items.

One Touch ID — Display the one touch ID number for the contact.
Prefix — Display the prefix for the contact.
First Name — Display the first name of the contact.
Last Name — Display the last name of the contact.
Suffix — Display the suffix for the contact.
Display Name — Display the display name of the contact.
Company — Display the company name of the contact.
Department — Display the department name of the contact.
Fax — Display the 1st fax number of the contact.
Second Fax — Display the 2nd fax number of the contact.
E-mail Address — Display the e-mail address of the contact.
Notes — Display the notes for the contact.
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Sending Options Tab
In the Sending Options tab, following items are displayed:

When displaying the properties of a contact in the private address book, you can modify the fol-
lowing settings:
- Use Sub Address and sender information
- Sub Address
- Sender Identification
Items other than the above cannot be set.

Use Device Settings — This is checked when the contact is set to use the device settings 
rather than using the settings on this tab.
Use Sub Address and sender information — This is checked when the subaddress trans-
mission for this contact is enabled.  When this is checked, a document will be always sent 
using the specified sub address and SID.  Also you can use this contact to perform polling 
transmission from the mailbox in the remote facsimile using the specified sub address and 
password.
Sub Address — Display the sub address or mailbox number of remote facsimile where a 
document will be sent.
Sender Identification — Display the security password for the sub address if required.
Selective Polling — Display the mailbox number of remote facsimile where a document will 
be retrieved.
Password — Display the password for the selective polling if required.
Overseas Calls — This is checked when calling the contact fax number will be oversea call.
Error Correction Mode — This is checked when the ECM for this contact is enabled.
Print Transmission Report — This is checked when printing the transmission report after 
the transmission is enabled.
Reduction — This is checked when the attenuation is enabled.
Short Protocol — This is checked when the short protocol is enabled.
Line Monitor — This is checked when the Line Monitor for the fax transmission is enabled.
Line Selection — Display whether the line 1 or line 2 is used for the fax transmission.  The 
line 2 can be selected only when optional Line 2 board is installed.
Transmission Type — Display whether the memory transmission or direct transmission is 
used for the transmission.
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Internet Fax Mode — Display whether the simple mode or full mode is used for the Internet 
Fax transmission.
Setting Value — Display whether to use auto detect receiver capability or manual settings 
for the Internet Fax transmission.  When “Default” is selected, it enable auto detect receiver 
capability for the Internet Fax transmission.  When “Custom” is selected, it uses custom set-
tings specified in the “Receiver Capability” option for the Internet Fax transmission.
Receiver Capability — Display the receiver capabilities settings, such as resolution, com-
pression, and page width.  These are applied to the transmissions only when “Custom” is 
selected in the “Setting Value” option.

Security Tab (public address book only)
In the Security tab, following items are displayed:

Owner — Display the owner name of this contact.
Password — Display the password of this contact.
Editing Date — Display the date that this contact is created.

— Removing Contacts
You can remove contacts from the private address book.
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Removing contacts from address book

1 Browse the folder that contains contacts you want to remove, and 
select contacts in the right pane.

2 Click the [File] menu and select [Delete].

The Confirmation Deletion dialog box appears.

3 Click [Yes].

The selected contacts are deleted.
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Managing Groups
You can add groups to the “Group” folder in the Private Address Book.  Groups can be used for 
multiple transmission.

 P.92 “Creating Groups”
Also you can modify or delete contacts in the private address book.

 P.93 “Modifying Groups Name”
 P.94 “Removing Groups”

After you create a group, you can add or delete contacts in the group.  For the instruction to add 
contacts in a group, please refer to the following section.

 P.83 “Managing Contacts”

— Creating Groups
You can create groups in the “Group” folder in the private address book.

Creating groups

1 Select the “Group” folder in the “Private Address Book” folder.

2 Click the [File] menu and select [New Group].

The Group dialog box appears.
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3 Enter a group name in the “Group Name” field.

The “Group ID” field displays the Group ID number automatically detected.

4 Click [OK].
The group is created in the selected “Group” folder.

5 Continue to add contacts to the group.
 P.83 “Managing Contacts”

— Modifying Groups Name
You can change the group name of the groups in the private address book.  You can also display 
the properties of a group in the public address book.

Modifying the group name

1 Select the group that you want to display or modify the group prop-
erties in the “Group” folder either of the private address book and 
public address book.

2 Click the [File] menu and select [Properties].

The Group dialog box appears.
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3 When you display the properties of the group in the private address 
book, modify the group name in the “Group Name” field and click 
[OK].

The group name of selected group is modified.

You cannot modify the group of the public address book.

— Removing Groups
You can delete groups in the private address book.

When you delete a group, contacts added in the group are also deleted.
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Removing a group

1 Select the group that you want to delete in the “Group” folder of the 
private address book.

2 Click the [File] menu and select [Delete].

The Confirm Deletion dialog box appears.

3 Click [Yes].

The selected group is deleted.
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Searching Contacts
In order to quickly locate contacts you can search the Address Book database. You simply type 
in a string or letters to be used to search the database. The Address Book Viewer will search for 
any entry that contains the specified string.
You can search contacts by the name, fax number, and e-mail address.  Also you can search 
contacts by specifying the detailed search conditions.

If the Address Book Viewer is launched by clicking [Select From Address Book] in the N/W-Fax 
driver, you can add the searched contacts as recipients for N/W-Fax.

Searching contacts by name, fax number, and e-mail address

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a address book to search contacts in the “Data Source” drop 
down box.

The default address book in the “Data Source” can be set by selecting [View] - [Default 
Configuration] - [Data Source] from the menu bar.
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3 Display the Person tab and enter search text in the following fields 
that you require.

Display Name — Enter the search characters or string to search by the display name.
Fax Number — Enter the search characters or string to search by the contact fax 
number.
E-Mail — Enter the search characters or string to search by the contact e-mail address.

You must enter one of the field to search contacts.  It will search the contacts that have 
exactly same name, fax number, or e-mail address as the entered search strings.

If you want to clear entered values, click [Clear All].

4 Click [Search].
It begins searching contacts in the selected address book.  When it completes 
searching, found contacts appear in the list at the bottom of the dialog box.
If the Address Book Viewer is launched by clicking [Select From Address Book] in the 
N/W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.

 P.100 “Adding contacts as recipients for N/W-Fax”

If you want to stop searching, click [Stop].
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Searching contacts by detailed search conditions

1 Click the [Edit] menu and select [Find].

The Find Contact dialog box appears.

2 Select a address book to search contacts in the “Data Source” drop 
down box.

The default address book in the “Data Source” can be set by selecting [View] - [Default 
Configuration] - [Data Source] from the menu bar.

3 Display the Detail Setting tab and select a field to search in the 
“Field Select” drop down box.
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4 Select how it searches contacts in the “Condition of search string” 
drop down box.

Contains — Select this to search contacts that contain the search string.
Is — Select this to search contacts that completely match the search string.
Start with — Select this to search contacts that start with the search string.
End with — Select this to search contacts that end with the search string.

5 Enter the search string in the next field to the “Condition of search 
string” drop down box.

6 Click [Add].
Specified search condition is added to the condition list.

If you want to clear entered values, click [Clear All].

7 Repeat the procedure from Step 3 to Step 6 to add all required con-
ditions.

You can remove the search conditions you have added.  To do this, select the condition 
and click [Delete].
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8 Click [Search].
It begins searching contacts in the selected address book.  When it completes 
searching, found contacts appear in the list at the bottom of the dialog box.
If the Address Book Viewer is launched by clicking [Select From Address Book] in the 
N/W-Fax driver, you can add the searched contacts as recipients for N/W-Fax.

 P.100 “Adding contacts as recipients for N/W-Fax”

If you want to stop searching, click [Stop].

Adding contacts as recipients for N/W-Fax

If the Address Book Viewer is launched by clicking [Select From Address Book] in the N/W-Fax 
driver, you can add the searched contacts as recipients for N/W-Fax.

1 Select the searched contacts and click [Address].

The Type Selection dialog box appears.

2 Check the “Email Address” check box if you want to add the Email 
address of the selected contacts as the destinations, and check the 
“Fax Number” check box if you want to add the fax number of the 
selected contacts as the destinations.

The default destination type in the “Type Selection” dialog box can be set by selecting 
[View] - [Default Configuration] - [Type Selection] from the menu bar.

3 Click [OK].
The Destinations dialog box appears.
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4 Click [OK].

The selected contacts are added as recipients for N/W-Fax.

Converting the Address Book Data
Using the Address Book Converter, users can convert the GL-1010 or GL-1020 address book 
file to the file that can be restored or imported to the e-STUDIO3510c Series, e-STUDIO451c 
Series, e-STUDIO850 Series, e-STUDIO853 Series, e-STUDIO4511 Series, e-STUDIO450 
Series, e-STUDIO453 Series, e-STUDIO280 or e-STUDIO283 Series Series with TopAccess.
The Address Book Converter can convert the two kinds of the address book file that is created 
from the GL-1010 or GL-1020 address book; one is the Address Book Converter file (*.abc) that 
can be created using the backup function of the TopAccess, and the other is the CSV file that is 
created using the export function of the TopAccess.

 P.102 “Converting from an address book converter file”
 P.104 “Converting from a CSV file”

The Address Book Converter can be launched only on Windows NT 4.0, Windows 2000, 
Windows XP, and Windows Server 2003.
To use the Address Book Converter, Java 2 Runtime Environment V1.4.2 must be installed.
The Address Book Converter is displayed only when an OS with a 32-bit version is used.
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Converting from an address book converter file

1 Click the [Tools] menu and select [Convert for TopAccess].

The Converting AddressBook dialog box appears.

2 Click [Browse] at the next of the “Input file” field.

3 Locate the folder that contains the address book converter file 
(*.abc).  Select “ABC (Address Book Converter) (*.abc)” in the 
“Files of type” drop down box, select the file, and click [Open].
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4 Select the model name that the selected file is originally created 
from in the “Machine Type” drop down box.

5 Click [Browse] at the next of the “Output File” field.

6 Locate the folder where you want to save a converted file. Select 
“TBF (Restore) (*.tbf)” in the “Save as type” drop down box and 
click [Save].

When you selected an Address Book Converter file for the input file, do not specify “CSV 
(Comma Separated Values) (*.csv)” in the “Save as type” drop down box.  The Address 
Book Converter file cannot convert to a CSV file.
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7 Click [Convert].

It starts converting a file.

8 Click [OK].

The file is converted and saved in the selected folder.

After you convert the file, you can restore or import the address book into the equipment 
using the restore or import function of the TopAccess.  For instructions on how to restore 
or import the address book, refer to the TopAccess Guide.

Converting from a CSV file

1 Click the [Tools] menu and select [Convert for TopAccess].

The Converting AddressBook dialog box appears.
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2 Click [Browse] at the next of the “Input file” field.

3 Locate the folder that contains the CSV file.  Select “CSV (Comma 
Separated Values) (*.csv)” in the “Files of type” drop down box, 
select the file, and click [Open].

4 Select the model name that the selected file is originally created 
from in the “Machine Type” drop down box.

5 Click [Browse] at the next of the “Output File” field.
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6 Locate the folder where you want to save a converted file. Select 
“CSV (Comma Separated Values) (*.csv)” in the “Save as type” drop 
down box, enter the file name in the “File name” field, and click 
[Save].

When you selected a CSV file for the input file, do not specify “TBF (Restore) (*.tbf)” in 
the “Save as type” drop down box.  The CSV file cannot convert to a Restore file.

7 Click [Convert].

It starts converting a file.

8 Click [OK].

The file is converted and saved in the selected folder.

After you convert the file, you can restore or import the address book into the equipment 
using the restore or import function of the TopAccess.  For instructions on how to restore 
or import the address book, refer to the TopAccess Guide.
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N/W-Fax Driver Errors

N/W-Fax Driver Installation Error Messages

Setup Needs to Copy Windows NT Files

Problem Description
The wrong port type was selected from the Printer Ports dialog.

Corrective Action
1. Click Cancel until the Add Printer Wizard terminates.
2. Double-click Add Printer from the Printers folder but, when prompted to select a port, choose 

Local Port.

Client Software CD Now Required

Problem Description
When adding a new printer driver, the end user did not choose the Have Disk option; instead, he 
selected the printer name from the Add Printer list.

Corrective Action
1. Cancel the Add Printer Wizard.
2. Double-click Add Printer from the Printers folder but, when prompted to locate the driver, 

click Have Disk.
3. Select Use Existing Driver to add another copy of an existing driver or browse to the subdi-

rectory that contains the appropriate *.inf file.

File *.DRV on Client CD Could Not Be Found

Problem Description
When adding a new printer driver, the user did not choose the Have Disk option but selected the 
printer name from the Add Printer list.

Corrective Action
1. Cancel the Add Printer Wizard.
2. Double-click Add Printer from the Printers folder, but when prompted to locate the driver, 

click Have Disk.
3. Browse to the subdirectory that contains the appropriate *.inf file.

Location Does Not Contain Information About Your Hardware

Problem Description
The path to the *.inf file selected during driver installation is too far away. In other words, there 
are too many characters in the directory path.

Corrective Action
Copy the directory containing the *.inf file to the local drive and resume installation.
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This Port is Currently in Use

Problem Description
The driver was either open, printing a job, or is in use by another printer or application, when you 
attempted to delete it.

Corrective Action
Make sure all print jobs have completed before deleting a port. If there are still problems, exit all 
applications and try again. Check each driver to see if another driver is using the same port. If 
so, first change the driver’s port setting and delete the port.

Problem with the Current Printer Setup

Problem Description
The driver was not set up properly, possibly because the installation procedure did not complete.

Corrective Action
Delete the driver and either reinstall it from the distribution CD-ROM or download it from this 
equipment.
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N/W-Fax Driver General Errors

Driver Mapped to Wrong Port

Problem Description
If the N/W-Fax driver on a client workstation points to the wrong network port, jobs do not appear 
in the current jobs queue or print out.

Corrective Action
1. Open the Printers folder from the Control Panel.
2. Right-click the printer driver icon.
3. Select Properties from the shortcut menu.
4. Depending on the operating system, select the following tab:

- In Windows 98/Me — Select Details. Browse to select the printer or Novell queue.
- In Windows NT 4.0/2000/XP/Vista/Server 2003 — Select Ports. Add a new port and map 

it to the printer.
5. Make sure that the path to the printer and the device name are correct.

\\<device name>\print
- Where <device name> is the same as the device name set from the Touch Panel Display.

6. Click the General Tab and click Print Test Page to confirm that the settings are correct.

“Could not connect to the MFP device” Appears.

Problem Description
When users are trying to access the properties of the Network Fax driver, an error message 
“Could not connect to the MFP device” appears.

Corrective Action
Communication between the Network Fax driver and this equipment failed. Make sure that this 
equipment is operating. If not, turn its power ON.
Connect the Network Fax driver with this equipment through the TopAccess. If connection fails, 
reboot the computer and this equipment.

Address Book Viewer Related Errors

Cannot Select from Address Book

Problem Description
The Address Book is not opened even if the [Select From Address Book] is pressed.

Corrective Action
The Address Book Viewer may not be installed.
Make sure that the Address Book Viewer is installed when you use [Select From Address Book].
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Cover Sheet Samples

Standard Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Business Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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Professional Cover Page

Reference Number: 
   0000000000000000
To:
   00000000001
From:
   MFP-00C67861
Subject:
   N/W-Fax Document
Message:
  This is a N/W-Fax Document.
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